COGNOS – Query Studio

Chapter 6 – Using the DU Templates

Apply Template

Chapter 7 – Advanced Reports

Create a Calculation
Crosstab Report
Conditional Formatting
Open a Query Studio Report in Report Studio

Chapter 8 – Charts

Create Chart
Create your own new chart report

Chapter 9 – Additional Documentation

ODS Metadata
More HELP

Chapter 10 – Guidelines

Who Should be Doing What?
Guidelines for Publishing Cognos Reports
**Chapter 1 – Getting Started**

### Overview of Cognos 8

**Cognos** modules available to University of Denver

- Metric Studio
- Event Studio
- Analysis Studio
- Query Studio
- Report Studio
- Cognos Viewer

**Cognos Connection** – Web portal used to access all application-specific data available in Report Studio. You will usually access Cognos from the Banner Tab.

**Framework Manager** – Use to create and publish metadata models on which reports are based. These metadata models (packages) are similar to what we have known as the Banner Reporting Views. Refer to the supplied diagrams (or documentation on webCentral) for information regarding your packages.

**Cognos View** – Use to monitor performance against benchmarks and priorities (AIS).

**Event Studio** – Use to invoke tasks, and track events and processes (AIS).

**Query Studio** – Use to create ad hoc reports, this is the tool you will be using.
Analysis Studio – Use to explore and analyze data (AIS).

Report Studio – Use to create managed reports. This is a more complex tool than Query Studio, in addition to the AIS staff there are just a few people at DU that will be using this interface.

Cognos Viewer – Use to view results of all reports, queries, and analyses.

What is Query Studio?

Query Studio is the module of Cognos 8 intended to allow users to quickly and easily create “ad-hoc” reports and queries. Users with a wide range of skills and experience can build Query Studio reports to:
- view data
- manipulate data
- save their report and use it to view the most recent data
- print a report or save it in another format such as PDF or Excel
- share query results with other users

Query Studio or Report Studio?

Determining whether to use Query Studio or Report Studio depends on a number of factors:
- Type of user
  - Technical skills
  - Knowledge of SQL fundamentals
  - Reporting experience
  - Knowledge of the data
- Type of information required
  - Level of complexity
  - Source of data – multiple tables
- Formatting/aesthetics requirements
  - Official published report vs. a query for internal use
- Personal preference
- Cognos Licensing

NOTE

A report can be created in Query Studio and easily opened in Report Studio for further editing and enhancements. However, once that report has been edited in Report Studio, it can no longer be opened with Query Studio.
Getting Started

1. To begin working with Query Studio, login to webCentral with your ID number and passcode – click the Cognos Tab

2. The Welcome Page will appear with links to the Cognos modules available.

   NOTE: there is an option to uncheck the “Show this page in the future” box in order to bypass this page.

3. Click on the Cognos Content link and the Cognos portal will appear – this is the primary way to access Query Studio and the associated query tools.
Navigating in Cognos Connection

4. Click **Public Folders**.

5. Navigate to the **Training Folder- Query Studio Training** folder, using the page scrollbars, and click to open.

6. Click on the **Public Folders** link to navigate back up.

**NOTE:** You can always click the “Home” button to return to Cognos Home!
Folder Tools

7. Within Public Folders review the Cognos Connection interface, the toolbar and the actions that can be performed in the portal.

![Cognos Connection Interface]

- Refresh the portal
- Show entries in a list
- Show details
- Create a folder
- New Job Wizard
- New URL Wizard
- New Page Wizard
- Cut
- Copy
- Paste
- Delete
- Properties

NOTE

These buttons only appear where they are relevant. On some pages they will not be displayed.

8. Click on the “My Folders” tab to navigate to your personal work space.
9. As part of this training, you will be creating your own queries as well as modifying existing reports. All of the reports that you work with should be stored in a separate training folder within your My Folders tab.


11. Select the New Folder button in the toolbar.

12. Create a new folder called Query Studio Training. Specify an optional Description, or add a Screen tip that will become visible as you mouse over your folder name (My first Query Studio Training).

13. Click Finish.
Chapter 2 – Examine a Query Studio Report

In this chapter, we will get acquainted with the Query Studio interface by viewing and editing an existing report. Cognos provides several ways to access Query Studio, including:

- Choose the Cognos Content option from the Welcome Page.

- Navigate to Public Folders / Training Folder / Query Studio Training

- Launch Query Studio by choosing the **Open with Query Studio** button from the Actions menu in Cognos Connection.

To edit an existing Query Studio report, you may access it either from Cognos Connection or from within Query Studio.

If the options listed above are not available, you have left the Cognos Connection.
Run an Existing Report

1. To make sure that we do not make unwanted changes to the original report, we will save a copy of the report from Public Folders to the Query Studio Training folder that we created earlier in your My Folders tab.

   a. Navigate in Cognos Connection to Public Folders > Training-Query Studio > Financial Aid Funds, this time by using the Search feature in Cognos Connection instead of the page scrollers.

   b. Check the box next to the Financial Aid Funds report and click on the Copy button in the toolbar.

   c. Navigate to My Folders > Query Studio Training and click on the Paste button in the toolbar.

2. View the newly copied report by clicking on the Run with Options button under Actions.
3. The Run with Options window is displayed, allowing you to select output formats, language, and delivery options.

4. Use the default options for now and click Run.

5. When the report includes prompts, you can select the value(s) to filter the query on.

   Select one of the prompts and click “Finish”
6. The report will display in Cognos Viewer as shown:

7. Note that Query Studio displays the filter parameters and sorting options that have been applied.
Cognos Viewer

While viewing a report in Cognos Viewer, you can perform many actions that are available from the Run with options and the Advanced options pages.

- Keep this version
- Run – if you wish to run the report again
- View in different formats
- Add this report
- Open with Query Studio or Report Studio (options depend on access)
  NOTE: If you open a Query Studio report with Report Studio you will no longer be able to open it with Query Studio
- After viewing, clicking the blue arrow will return you to the folder you launched the report from
8. Return to the Cognos Connection Home and navigate to the folder that contains the copy of the Financial Aid Funds report.

Clicking on the report name itself to view a report may or may not display the most current data. For more consistent results we recommend that you always “Run with Options”.

Open an Existing Report in Query Studio

You can open an existing report in Query Studio to view the most current data in the query, to make changes to the report, or to use it as the basis of a new report.

9. In the Actions options for the Financial Aid Funds report, click on the Open with Query Studio button.
10. The Query Studio interface will be displayed.

11. If you select Scholarship and click Finish, you will run the report just as you did above, beginning with Step #2.

12. The primary Query Studio Menu options are available in the upper-left corner of the screen.
13. Options available within each main menu item are displayed in the panel below the main menu, and change depending on the selection.

14. Select the Run Report menu to view all of the output formats available in Query Studio.
15. Again from the Run Report menu, choose the option to Preview with No Data and review the report structure.

a. The Preview with No Data option allows you to focus on the report layout. It can be helpful to use this option as you are developing queries and until you have determined:
   - The specific fields you want to include in the query,
   - The format you prefer for the report,
   - How you want to limit the data returned by applying filters.

16. Selecting the Preview with Limited Data option will give you a better feel for the content of the items you have selected, without returning all of the data in the query. Note however, that in order for this option to function properly, a “design mode filter” must have been applied to the package the report is using in Framework Manager.

17. Once you are ready to test a report, or to view an existing report, run the report with all data by:
   a. Clicking on the Run with All Data link in the Run Report menu
   b. Using the Run button in the toolbar
   c. Clicking on the Run all data link at the bottom of the screen.

Viewing your report using the Run with All Data option - before you are certain that you have selected the correct data items and have applied the appropriate filters - may cause a query to run for a long time before displaying results!

When creating a new report it is a good practice to Run with Limited Data as your report will re-query the database with each field you add to your report.
Examine the Query Filters

18. Continuing from the previous exercise, the funnel button indicates that one or more filters have been applied to the data.

   AID_YEAR: 0607 AND FUND_TYPE_DESC:

   FUND_TITLE: Ascending order

19. Click on the funnel to display the filter definition. This report has two filters, and is using the AND operator to indicate that both conditions must be true.

   Data is turned off
   Combine filters

   Use the Detail tab to apply the filter to individual values in the data source.

   Filter
   AID_YEAR: 0607
   AND FUND_TYPE_DESC:

   OK Cancel Apply

20. Click on the AID_YEAR:0607 filter (to the right of the funnel button)

   AID_YEAR: 0607 AND FUND_TYPE_DESC:

   FUND_TITLE: Ascending order
21. A checkbox prompt shows all of the available aid years to choose from. Note that the combination of selecting 0607, and leaving the Prompt every time the report runs unchecked is the equivalent of “hard-coding” a filter in your query.

![Filter (Pick values from a list)](image)

Reduce the amount of data in the report. With the Prompt option selected, the filter can be changed each time the report runs.

- **Filter on:** AID_YEAR
- **Condition:** Show only the following

<table>
<thead>
<tr>
<th>Value</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0001</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0102</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0203</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0304</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0405</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0505</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0607</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>0708</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Select all  Deselect all

- **Missing values:** *(Default)*
- **Apply the filter to individual values in the data source**

![Filter Options](image)

22. Click on the Condition down arrow to see that you also have the option to filter on conditions that are NOT true.

- **Condition:** Do not show the following (NOT)
23. Next, click on the FUND_TYPE_DESC link next to the filter funnel and note that checking the Prompt every time the report runs option allows the user to select the filter.

Filter on:
FUND_TYPE_DESC

Condition:
Show only the following

- Books
- Fees
- Grant
- Loan
- Room and Board
- Scholarship
- Waiver
- Work

Select all Deselect all

Missing values (Default)
Apply the filter to individual values in the data source

OK Cancel

24. Click on the Save as button in the toolbar and save this report under a new name in My Folders > Query Studio Training. Verify that the Location reflects the correct path – if not, click on the Select another location link to modify it.

Location:
My Folders > Query Studio Training > Chapter2
Select another location...

25. Return to Cognos Connection by clicking on Return or the Cognos Connection link.
Cognos and Query Studio Tips

As you work with Cognos and Query Studio, keep these tips in mind for easier use and better performance.

- **It doesn’t work like a browser.** Cognos does not fully support the functionality of the Internet Explorer browser. For example, you may notice that sometimes the Back button works and sometimes you will get errors or no response at all. You will have the best success if you use the navigation within the Cognos interface rather than using browser navigation.

- **Navigate to the Bottom for faster performance.** Running a report in HTML will display navigation options at the bottom of the screen. If you pick Page down, the report needs to re-run. Choose Bottom instead which will place the entire report into memory (cache) and allow you to more quickly move between pages.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0607</td>
<td>Assn for Corporate Growth Schl</td>
<td>Scholarship</td>
</tr>
<tr>
<td>0607</td>
<td>Athl. 5th year R&amp;B</td>
<td>Scholarship</td>
</tr>
</tbody>
</table>

Jul 15, 2007

[Page down]  [Bottom]
Chapter 3 – Create a Simple List Report

With Query Studio, you create, view, and run different report types to look at data in different ways or to answer different business questions. Report styles available in Query Studio include:

  - List reports can show each line of detail in a data set, or group similar items together, eliminating duplicate rows (Grouped List Report)

- Crosstab Report – shows a value at the intersection of each row and column.

- Charts – show data in various graphical formats.
Packages

New reports are created by inserting items from a “package” into an empty report. Packages are created and “published” from the Cognos Framework Manager application. A Cognos package will normally group data from the organization’s underlying data sources into smaller, closely related, and logical subsets. All of the required relational links are created in the package. Refer to the supplied diagrams (or documentation on webCentral) for information regarding your packages.

As you are looking through the packages you have been granted access to, whenever possible, select the package labeled “DU” as that package has been modified and will work better for our reporting here at the University of Denver.

NOTE

We recommend that you refer to the ODS Meta Data information as you are creating your reports. Please see Chapter 9 for more information.
Create a New Query Studio Report

1. To create a simple list report, launch Query Studio and select the “Financial Aid Award and Disbursement DU” package by either selecting it from the Recently used packages dropdown, or using the blue navigation buttons to scroll through the folders.

If there are two packages with names that are similar but one is labeled “DU” you will want to select the “DU” package.

**NOTE:** Until you have created queries of your own, you will not see options in the Recently used packages list.

2. Click once on the + sign in front of Financial Aid Award and Disbursement to expand the group, then again on the Award By Fund group.
3. Add items to your report:
   
   a. To select items for the report you have the following options:
      - Click once to select a single item.
      - [CTRL] + click to highlight multiple items.
      - [SHIFT] + click to highlight a contiguous group of items.
   
   b. You can add the selected item(s) to the report by:
      - Double-clicking a single item.
      - Click the Insert button at the bottom of the Insert Data panel
      - Click and drag the data items into the report.
   
   c. Add the following fields to your new report:
      - AID_YEAR
      - FUND_SOURCE_DESC
      - FUND_TYPE_DESC
      - PAID_AMT

4. Your report should look like this:

<table>
<thead>
<tr>
<th>AID_YEAR</th>
<th>FUND_SOURCE_DESC</th>
<th>FUND_TYPE_DESC</th>
<th>PAID_AMT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0203</td>
<td>Undergraduate Discount</td>
<td>Scholarship</td>
<td>19,480,748.99</td>
</tr>
<tr>
<td>0102</td>
<td>Gift &amp; Endowed Allowance</td>
<td>Scholarship</td>
<td>2,227,721.34</td>
</tr>
<tr>
<td>0203</td>
<td>Gift &amp; Endowed Allowance</td>
<td>Scholarship</td>
<td>3,240,646.17</td>
</tr>
<tr>
<td>0304</td>
<td>Gift &amp; Endowed Allowance</td>
<td>Scholarship</td>
<td>3,242,842.00</td>
</tr>
<tr>
<td>0102</td>
<td>Departmental Funded Schl</td>
<td>Room and Board</td>
<td>302,499.00</td>
</tr>
<tr>
<td>0203</td>
<td>Departmental Funded Schl</td>
<td>Room and Board</td>
<td>376,251.80</td>
</tr>
<tr>
<td>0102</td>
<td>Departmental Funded Schl</td>
<td>Books</td>
<td>0.00</td>
</tr>
<tr>
<td>0405</td>
<td>Departmental Funded Schl</td>
<td>Books</td>
<td>0.00</td>
</tr>
<tr>
<td>0102</td>
<td>Departmental Funded Schl</td>
<td>Fees</td>
<td>65,599.00</td>
</tr>
<tr>
<td>0405</td>
<td>Departmental Funded Schl</td>
<td>Fees</td>
<td>437,874.00</td>
</tr>
<tr>
<td>0102</td>
<td>Undergraduate Federal</td>
<td>Scholarship</td>
<td>6,250.00</td>
</tr>
<tr>
<td>0203</td>
<td>Gift &amp; Endowed Allowance</td>
<td>Waiver</td>
<td>0.00</td>
</tr>
<tr>
<td>0102</td>
<td>Undergraduate State</td>
<td>Grant</td>
<td>1,510,656.00</td>
</tr>
</tbody>
</table>

Delete a Column

5. Click in the column you want to delete (FUND_SOURCE_DESC), then:
   
   a. Click the Delete button in the toolbar, or
   
   b. Right-click on the column to find Delete in the shortcut menu, or
   
   c. Select Delete from the Edit Data menu.
6. We didn’t really want to delete this column, so we will use one of the most useful functions in Cognos – the Undo button. If you make any mistakes, either before or after saving (as long as you haven’t already closed the query), the Undo feature works extremely well and saves the last 10 actions.

### Change the Column Order

You can reorder columns in a report by using the **Cut** and **Paste** functionality that you know from other programs. Now that you have seen the data, you decide you want to switch FUND_TYPE_DESC and FUND_SOURCE_DESC.

7. Click in the FUND_TYPE_DESC column, and click on the Cut button in the toolbar.

<table>
<thead>
<tr>
<th>AID_YEAR</th>
<th>FUND_SOURCE_DESC</th>
<th>FUND_TYPE_DESC</th>
<th>PAID_AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001</td>
<td>Gift &amp; Endowed Allowance</td>
<td>Scholarship</td>
<td>20,800.00</td>
</tr>
<tr>
<td>0102</td>
<td>Departmental Funded Schl</td>
<td>Books</td>
<td>0.00</td>
</tr>
<tr>
<td>0102</td>
<td>Departmental Funded Schl</td>
<td>Fees</td>
<td>65,569.00</td>
</tr>
</tbody>
</table>

8. FUND_TYPE_DESC becomes grayed out. Next, click in the FUND_SOURCE_DESC column, and click the Paste button in the toolbar.

<table>
<thead>
<tr>
<th>AID_YEAR</th>
<th>FUND_SOURCE_DESC</th>
<th>FUND_TYPE_DESC</th>
<th>PAID_AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001</td>
<td>Gift &amp; Endowed Allowance</td>
<td>Scholarship</td>
<td>20,800.00</td>
</tr>
<tr>
<td>0102</td>
<td>Departmental Funded Schl</td>
<td>Books</td>
<td>0.00</td>
</tr>
<tr>
<td>0102</td>
<td>Departmental Funded Schl</td>
<td>Fees</td>
<td>65,569.00</td>
</tr>
</tbody>
</table>
9. **FUND_TYPE_DESC** is inserted to the left of the selected column.

<table>
<thead>
<tr>
<th>AID_YEAR</th>
<th>FUND_TYPE_DESC</th>
<th>FUND_SOURCE_DESC</th>
<th>PAID_AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0506</td>
<td>Scholarship</td>
<td>Graduate Gift &amp; Endowed</td>
<td>1,118,362.36</td>
</tr>
<tr>
<td>0102</td>
<td>Room and Board</td>
<td>Departmental Funded Schl</td>
<td>302,409.00</td>
</tr>
<tr>
<td>0607</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td></td>
</tr>
<tr>
<td>0809</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td></td>
</tr>
<tr>
<td>0708</td>
<td>Work</td>
<td>Undergraduate Federal</td>
<td>538,064.23</td>
</tr>
<tr>
<td>0102</td>
<td>Waiver</td>
<td>Gift &amp; Endowed Allowance</td>
<td>6,670.00</td>
</tr>
</tbody>
</table>

**NOTE**

To more easily preview report data and layout, you can temporarily hide the Query Studio menu as shown below. Toggle the arrow a second time to show the menu again.

---

**Sorting Data**

You can sort data in ascending or descending, alphabetical or numeric order. When sorting grouped data, you can sort the detail values, or you can sort the summary values in the footers.

The default sort order in Query Studio is ascending order. You can sort by selecting multiple fields; however, the sort priority will be from left to right where the leftmost column will be sorted first.

10. Click once in the **FUND_TYPE_DESC** column.
11. Click the **Sort** button in the toolbar.
12. The report is now sorted on FUND_TYPE_DESC, and also displays the sort option above the report.

<table>
<thead>
<tr>
<th>AID_YEAR</th>
<th>FUND_TYPE_DESC</th>
<th>FUND_SOURCE_DESC</th>
<th>PAID_AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0102</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td>0.00</td>
</tr>
<tr>
<td>0102</td>
<td>Books</td>
<td>Gift &amp; Endowed Allowance</td>
<td>0.00</td>
</tr>
<tr>
<td>0203</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td>6,000.00</td>
</tr>
<tr>
<td>0203</td>
<td>Books</td>
<td>Gift &amp; Endowed Allowance</td>
<td>27,000.00</td>
</tr>
<tr>
<td>0304</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td></td>
</tr>
<tr>
<td>0304</td>
<td>Books</td>
<td>Gift &amp; Endowed Allowance</td>
<td>30,000.00</td>
</tr>
<tr>
<td>0405</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td>43,527.00</td>
</tr>
</tbody>
</table>

13. Select the FUND_SOURCE_DESC column.

14. This time, open the Edit Data menu, and select the Sort option.

15. In the window that opens, select the Ascending radio button and click OK.

16. To remove sorting, select Edit Data > Sort and select the Don’t sort radio button.
Printing Reports

17. To quickly print the current screen without selecting an output option, right-click on the screen and then left-click on Print from the context menu.

18. It is safer to send the report to another output format such as PDF or Excel and print from that application, as you cannot always predict the behavior of the browser.

19. In the Run Report menu, select the View in PDF Format option.

20. The report opens in PDF format in Cognos Viewer. Click on the Printer button to print the report.

21. Close Cognos Viewer to return to Query Studio.
Saving a Report

22. Choose **Save** or **Save As** from the toolbar to save this report.

23. Click on Select another location and locate your Query Studio Training folder. Click OK

    **Location:**
    Public Folders > Financial Aid Award and Disbursement
    Select another location... Select My Folders

24. Save the report as Ch3-List.

**NOTE**
When you save a report in Query Studio, you are actually saving the report specification: a set of instructions for extracting and formatting a particular set of data. You are not saving a “snapshot” of the data. You can, however, generate the report in another output option, i.e. PDF or Excel, and save it to another location in order to reflect the state of the data at a particular point in time.
Create your own new list report

25. Before beginning a new report please refer to Chapter 9 for guidance:

   a. Decide which package you would like to use for your report. If there are two packages with almost the same name and one of them is labeled “DU” it is preferable to use the DU package.

   b. Before you begin make sure that you change the Run Report options to “Preview with Limited Data” so that it won’t take as long to create your report.

   c. Sort – remember that the sort order is from left to right
Chapter 4 – Filtering & Grouping Data

A simple list report typically displays rows and rows of detailed data which may or may not be terribly meaningful to the user. Most of the time, users want to narrow the data set by some sort of criteria, and remove redundant data by grouping and summarizing on similar data items.

“Filtering” limits the report to include only the data that matches your criteria.

“Grouping” chunks repeating data items together and organizes the report in a manner that makes it more readable and useful.

Filtering Data in Query Studio

1. Open with your Ch3-List report with Query Studio.

<table>
<thead>
<tr>
<th>AID_YEAR</th>
<th>FUND_TYPE_DESC</th>
<th>FUND_SOURCE_DESC</th>
<th>PAID_AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0102</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td>0.00</td>
</tr>
<tr>
<td>0203</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td>6,000.00</td>
</tr>
<tr>
<td>0304</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td>0.00</td>
</tr>
<tr>
<td>0405</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td>0.00</td>
</tr>
<tr>
<td>0506</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td>0.00</td>
</tr>
<tr>
<td>0607</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td>0.00</td>
</tr>
<tr>
<td>0708</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td>0.00</td>
</tr>
<tr>
<td>0102</td>
<td>Books</td>
<td>Gift &amp; Endowed Allowance</td>
<td>0.00</td>
</tr>
<tr>
<td>0203</td>
<td>Books</td>
<td>Gift &amp; Endowed Allowance</td>
<td>27,000.00</td>
</tr>
<tr>
<td>0304</td>
<td>Books</td>
<td>Gift &amp; Endowed Allowance</td>
<td>30,000.00</td>
</tr>
<tr>
<td>0405</td>
<td>Books</td>
<td>Gift &amp; Endowed Allowance</td>
<td>43,527.00</td>
</tr>
<tr>
<td>0506</td>
<td>Books</td>
<td>Gift &amp; Endowed Allowance</td>
<td>45,711.00</td>
</tr>
<tr>
<td>0607</td>
<td>Books</td>
<td>Gift &amp; Endowed Allowance</td>
<td>71,316.00</td>
</tr>
<tr>
<td>0607</td>
<td>Books</td>
<td>Undergraduate Discount</td>
<td>492.00</td>
</tr>
<tr>
<td>0102</td>
<td>Fees</td>
<td>Departmental Funded Schl</td>
<td>65,569.00</td>
</tr>
<tr>
<td>0203</td>
<td>Fees</td>
<td>Departmental Funded Schl</td>
<td>81,703.00</td>
</tr>
<tr>
<td>0304</td>
<td>Fees</td>
<td>Departmental Funded Schl</td>
<td>86,896.50</td>
</tr>
<tr>
<td>0405</td>
<td>Fees</td>
<td>Departmental Funded Schl</td>
<td>97,949.00</td>
</tr>
<tr>
<td>0506</td>
<td>Fees</td>
<td>Departmental Funded Schl</td>
<td>101,909.00</td>
</tr>
</tbody>
</table>
2. Note that the report reflects several years of data. Let’s assume that we only want to see this information for the most current AID_YEAR.

3. We can add a Filter on a specific report item by clicking once on the column heading of the item that you want to limit the data by. Click in the AID_YEAR column.

4. Select the Edit Data Menu, then select Filter.

5. The Filter dialog box will appear. The display will vary depending on the type of data you are filtering.
   a. When you filter on a numeric report item, you specify a range of acceptable values (for example, 1 to 5).
   b. When you filter on a date column, you will be prompted to select a “From” and “To” date range.
   c. When you filter on a non-numeric, non-date column, you specify particular values that will be returned when the report is run (for example, Scholarships). You can further decide whether to:
      - Pick values from a list
      - Search for values
      - Type in the values you want to use.

6. In this example, Cognos defaults to the Pick values from a list filter. Note that the default filter type is determined based on the “data type” that has been defined in the underlying database. Query items that appear to be numeric may often be defined as character values, as is the case with the AID_YEAR field.
7. Select the aid year and click OK.

8. Your report will only display data for the aid year selected.

<table>
<thead>
<tr>
<th>AID_YEAR</th>
<th>FUND_TYPE_DESC</th>
<th>FUND_SOURCE_DESC</th>
<th>PAID_AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0607</td>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td>1,698.00</td>
</tr>
<tr>
<td>0607</td>
<td>Books</td>
<td>Gift &amp; Endowed Allowance</td>
<td>69,618.00</td>
</tr>
<tr>
<td>0607</td>
<td>Books</td>
<td>Ugrad Departmental Funded Schl</td>
<td></td>
</tr>
<tr>
<td>0607</td>
<td>Fees</td>
<td>Departmental Funded Schl</td>
<td>573,104.20</td>
</tr>
<tr>
<td>0607</td>
<td>Fees</td>
<td>Gift &amp; Endowed Allowance</td>
<td>3,094.00</td>
</tr>
<tr>
<td>0607</td>
<td>Fees</td>
<td>Grad Departmental Funded Schl</td>
<td>12,334.00</td>
</tr>
<tr>
<td>0607</td>
<td>Fees</td>
<td>Private funding</td>
<td>32,470.00</td>
</tr>
<tr>
<td>0607</td>
<td>Grant</td>
<td>Graduate State</td>
<td>586,641.00</td>
</tr>
</tbody>
</table>
9. Add another filter for FUND_TYPE_DESC, click in the column and this time click the Filter button in the Toolbar.

10. Select Books from the list, and this time check the Prompt every time the report runs box. This will allow the user to select the FUND_TYPE_DESC each time they run the report.
11. Click OK and the Combine filters window will appear.

12. When you apply more than one filter to a report, Query Studio will ask which operator you want to use to combine the filters. Selecting AND means that BOTH criteria must be met. Selecting OR means that either criterion could be met. For this exercise, choose AND and click OK.

13. Your report is limited to Financial Aid that was paid in AID_YEAR 0607, AND only those amounts paid for Books.
14. Note that the report has also been summarized, and is automatically grouped at the lowest level of detail (FUND_SOURCE_DESCRIPTION). This behavior is explained by examining the Advanced Options within the Run Report menu.

<table>
<thead>
<tr>
<th>Run Report</th>
<th>Manage File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run with All Data</td>
<td>Preview with Limited Data</td>
</tr>
<tr>
<td>Preview with No Data</td>
<td></td>
</tr>
<tr>
<td>View in PDF Format</td>
<td>Specify PDF Options…</td>
</tr>
<tr>
<td>View in Excel 2007 Format</td>
<td></td>
</tr>
<tr>
<td>View in Excel 2002 Format</td>
<td></td>
</tr>
<tr>
<td>View in Excel 2000 Single Sheet Format</td>
<td></td>
</tr>
<tr>
<td>View in CSV Format</td>
<td>View in XML Format</td>
</tr>
<tr>
<td>Advanced Options…</td>
<td></td>
</tr>
</tbody>
</table>

**Advanced Options**

You can change how to process the underlying database query by clearing these options.

**Query Options**

- Automatically generate footer summaries for measures
- Automatically summarize detail values, suppressing duplicates

**Drill Options**

You can disable drilling in the report by clearing this option.

- Enable drill up and drill down in the report output
- Enable drill through from a package in the report output

15. By default, all detail rows are summarized and any duplicate rows are suppressed. If the data is grouped, a summary footer row is added to the bottom of each group.
16. Uncheck the **Query Options** and review the results.

17. The report now displays each row of detail, making it unnecessarily lengthy and more difficult to analyze.

18. Re-check these options to return to the Query Studio default.

---

**Delete a Filter**

19. If you determine that you no longer want to limit the FUND_TYPE_DESC, you can remove the filter by right-clicking in the header and selecting Delete.

20. You can also delete a filter by deleting the entire data column, an action which will give you the option to delete the filter as well, as we will see later.

21. Save the report as Ch4-Filter.
Additional Filtering Techniques

22. Create a new report by returning to Cognos Connection and opening Query Studio.

   NOTE: If you wanted to create a new report using the same package, you could click on the New Report button in the toolbar prior to returning to Cognos Connection.

23. Select the Grant and Project package.

24. From the Insert Data menu, expand the Grant and Project > Grant View folder.

25. Insert the following items into your report:
   a. STATUS
   b. PRINCIPAL_INVESTIGATOR_NAME
   c. GRANT_ID
   d. SHORT_TITLE
   e. AGENCY_NAME
   f. CUMULATIVE_AMT

26. Create a filter for STATUS and select “A”.

27. Once we have created the filter, it is redundant to include the STATUS column in the report.

28. Click in the STATUS column, then click Delete from the toolbar.

29. A window appears notifying you that a filter is associated with the column that you are deleting – you can choose to keep it by unchecking the box next to the filter.
30. Uncheck the box and click **OK**.

31. Sort on **PRINCIPAL_INVESTIGATOR_NAME** and **AGENCY_NAME**.

32. Add another filter for **PRINCIPAL_INVESTIGATOR_NAME**.

33. Check the **Prompt every time the report runs** box.

34. Since there are so many Principal Investigators, it makes sense to select the **Search for Values** filter type.
35. A **Search & Select** prompt appears, allowing you to search for a specific Principal Investigator name as shown.

36. Click OK.
37. Use the AND operator:

![Combine Filters](image)

38. Click OK, and review your report.

39. Save the report as **Ch4-Additional Filtering Techniques**

Using the **Search for Values** option allows for more flexibility in filtering, especially when expanding the **Options** link. You can Search and Select multiple times before running a report. To use the **Search for Values** option, you need to be in the **Query Studio** mode, **Edit Data**, **Filter**

**NOTE**

When you run the report again, the prompt will default back to the original prompt, but will keep the conditions that you selected with the **Search for values** option until you modify the search.
Create your own new filters report

26. Before beginning a new report please refer to Chapter 9 for guidance:

   a. Decide which package you would like to use for your report. If there are two packages with almost the same name and one of them is labeled “DU” it is preferable to use the DU package.

   b. Before you begin make sure that you change the Run Report options to “Preview with Limited Data” so that it won’t take as long to create your report.

   c. Create a report that has contains the following:
      - Multiple filters
      - Filter on a column not displayed on the page
      - Prompt filter
Create a Grouped List Report

If we review the format of the Ch4 Filter report – note the duplicate values in the AID_YEAR and FUND_TYPE_DESC columns.

<table>
<thead>
<tr>
<th>AID_YEAR</th>
<th>FUND_TYPE_DESC</th>
<th>FUND_SOURCE_DESC</th>
<th>PAID_AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0607</td>
<td>Books</td>
<td>Departmental Funded Sch</td>
<td></td>
</tr>
<tr>
<td>0607</td>
<td>Books</td>
<td>Gift &amp; Endowed Allowance</td>
<td>71,316.00</td>
</tr>
<tr>
<td>0607</td>
<td>Books</td>
<td>Ugrad Departmental Funded Scho</td>
<td></td>
</tr>
<tr>
<td>0607</td>
<td>Books</td>
<td>Undergraduate Discount</td>
<td>492.00</td>
</tr>
<tr>
<td>0607</td>
<td>Fees</td>
<td>Departmental Funded Sch</td>
<td>116,335.20</td>
</tr>
<tr>
<td>0607</td>
<td>Fees</td>
<td>Gift &amp; Endowed Allowance</td>
<td>3,094.00</td>
</tr>
<tr>
<td>0607</td>
<td>Fees</td>
<td>Grad Departmental Funded Schol</td>
<td>250.00</td>
</tr>
</tbody>
</table>

“Grouping” a report in Query Studio makes for a much more “user-friendly” report by eliminating duplicate values and by displaying subtotals for each grouped item. You can organize the grouped data by row headings or by creating “section” headings.

When you group a report by row headings, Query Studio:
- Automatically sorts the rows in the report.
- Eliminates duplication of the grouped row heading.
- Creates a “footer” for each group and displays summarized values for those items where summarization is appropriate (measures).

When you group a report by creating sections, Query Studio:
- Automatically sorts the rows in the report.
- Removes the “sectioned” item from the list report and displays it as a heading for the group.
- Creates a “footer” for each group and displays summarized values for the measures.

You cannot group by measures, such as PAID_AMT. You can only group report items containing text data or non-measure numeric data, such as FUND_TYPE_DESC.
40. Return to Cognos Connection and open your **Ch4-Filter** report in Query Studio.

41. Since we have filtered on **AID_YEAR**, the column in the report is redundant. Select it and click the **Delete** button. Do not delete the filter.

42. Click in the **FUND_TYPE_DESC** column, and select the **Group** button in the toolbar.
Expand and Collapse Data Groups

You can specify how much detail you want to show in a grouped report by expanding and collapsing groups.

43. Click on the Collapse Group button in the toolbar.

![Collapse Group button](image)

44. Query Studio will eliminate the FUND_SOURCE_DESC detail and summarize as follows:

<table>
<thead>
<tr>
<th>FUND_TYPE_DESC</th>
<th>PAID_AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>71,316.00</td>
</tr>
<tr>
<td>Fees</td>
<td>621,002.20</td>
</tr>
<tr>
<td>Grant</td>
<td>15,459,419.08</td>
</tr>
<tr>
<td>Loan</td>
<td>110,685,872.04</td>
</tr>
<tr>
<td>Room and Board</td>
<td>1,313,353.08</td>
</tr>
<tr>
<td>Scholarship</td>
<td>51,142,383.59</td>
</tr>
<tr>
<td>Waiver</td>
<td>6,554,825.25</td>
</tr>
<tr>
<td>Work</td>
<td>2,081,517.42</td>
</tr>
<tr>
<td><strong>Summary</strong></td>
<td><strong>187,939,688.66</strong></td>
</tr>
</tbody>
</table>

45. Click on the **Collapse Group** button a second time to eliminate the FUND_TYPE_DESC detail.

![Collapse Group](image)

<table>
<thead>
<tr>
<th>PAID_AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>187,939,688.66</td>
</tr>
</tbody>
</table>

46. Click on the **Expand Group** button twice to return to the original groups.

47. Save your report as **Ch4-Grouping**.
Group with Sections

An alternative to grouping in a report is to instead divide your report results into sections. When you group by section headings, you show the value of a selected report item as the heading of a section.

48. Continuing with Ch4-Grouping, remove the grouping level on FUND_TYPE_DESC by selecting the column and clicking on the Ungroup button in the toolbar.

49. This time, click in the FUND_TYPE_DESC column, and select the Create Sections button in the toolbar.

50. Query Studio has divided FUND_TYPE_DESCRIPTION into sections, removed it from the report, and added a heading at the top of each group.

51. Save your report as Ch4-Sections.
Create your own new grouped report

52. Before beginning a new report please refer to Chapter 9 for guidance:

   a. Decide which package you would like to use for your report. If there are two packages with almost the same name and one of them is labeled “DU” it is preferable to use the DU package.

   b. Before you begin make sure that you change the Run Report options to “Preview with Limited Data” so that it won’t take as long to create your report.
Chapter 5 – Modify Reports

As you create and edit reports, you can enhance the appearance of your report by:

- formatting text and data
- editing titles
- setting page breaks
- formatting borders

Formatting Data

1. Open your Ch4-Grouping report with Query Studio and click on the Edit Data menu.

2. Click in the PAID_AMOUNT column in your report, then select Format Data from the menu.
3. Change the format of PAID_AMOUNT from Default to Currency. Other options for formatting data include the number of decimal places, whether to “scale” the numbers, how to reflect negative numbers, and whether you want a comma separating the thousands.

4. Click **OK**

**Editing Column Headings and Titles**

5. While still in the Edit Data Menu, change the column titles by clicking in each column, then selecting the Rename Column Heading option. Change FUND_TYPE_DESC to FUND TYPE and FUND_SOURCE_DESC to FUND SOURCE.
6. To edit the title of the report:

   a. Select **Edit Title** from the **Change Layout** menu, or
   b. Click on the default **Title** at the top of the report.

7. You can also opt to show or hide the filters and sorts.

**Modifying Font Styles**

8. Click in the **PAID AMOUNT** column to select.

9. Select the **Change Layout** menu and click on the **Change Font Styles** option.
10. Change the Font Color to Blue.

11. The **Change font styles** options are also available in the **Style Toolbar**, or by right-clicking and selecting **Change font styles** from the shortcut menu.

12. Click on the Summary Row description, select the Background Color button in the in the Toolbar, and change the color to Yellow.
13. Right-click in the Summary Row values and select Change font styles.

14. Change the background color to Yellow, and click on Advanced Options.

15. Check Apply styles only to the selections below, select Group Summary values, and click OK.
Add Page Breaks

16. Click in the Summary row description, and in the Change Layout menu, select Set Page Breaks.

17. Run the report to find it now begins a new page with each change in Fund Type.

Financial Aid by Fund Type

by Source

<table>
<thead>
<tr>
<th>FUND_TYPE_DESC</th>
<th>FUND_SOURCE_DESC</th>
<th>PAID_AMOUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>Departmental Funded Schl</td>
<td>$71,316.00</td>
</tr>
<tr>
<td>Gift &amp; Endowed Allowance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ugrad Departmental Funded Scho</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undergraduate Discount</td>
<td></td>
<td>$492.00</td>
</tr>
<tr>
<td>Books</td>
<td></td>
<td>$71,808.00</td>
</tr>
</tbody>
</table>
18. To remove page breaks, highlight the Summary row description again, and select Yes in the Set page breaks dialog.

Modify Border Styles

19. In the Change Layout menu, select Change Border Styles, or click the Change Borders button in the toolbar.

20. Select Headings and Summaries, and the color Green.
21. The Reset Font and Border Styles link will remove the border style that you have applied.

22. Save your report as Ch5-Formatting.
Modify one of your own reports

23. Make the following changes to one of your reports:
   a. Title
   b. Column Headings
   c. Fonts and Borders
   d. Page Breaks
Chapter 6 – Using the DU Templates

There are currently 6 report templates which exist in mdb as well as the test instances. Here is the process for applying a template to your report.

Apply Template

1. Open a report that already exists, or create a new report.
2. Select Apply Template from the Change Layout Menu.
3. Click the link to Select a template
4. Navigate to:
   a. Cognos / Public Folders
   b. DU Report Templates
   c. Select the template which is most appropriate for your report
   d. Click OK
Chapter 7 – Advanced Reports

Some of the more advanced functionality in Query Studio includes the ability to:
- Add a calculated fields
- Create Crosstab reports
- Use conditional formatting

Create a Calculation

1. Open Query Studio and select the Grant and Project package.

2. From Grant and Project > Grant and Project > Grant View, insert
   a. STATUS
   b. GRANT_TYPE_DESC
   c. CATEGORY_DESC
   d. CUMULATIVE_AMT
   e. CURRENT_YEAR_AMT

3. Add a filter for STATUS = 'A'.

4. Add a second filter on GRANT_TYPE_DESC.
   a. Change the condition to the Do not show the following (NOT) option
   b. Select:
      - Other
      - Plant and Projects
      - Small Projects
   c. Use the AND operator
   d. Click OK
5. Sort ascending on GRANT_TYPE_DESC and CATEGORY_DESC

<table>
<thead>
<tr>
<th>STATUS</th>
<th>GRANT_TYPE_DESC</th>
<th>CATEGORY_DESC</th>
<th>CUMULATIVE_AMOUNT</th>
<th>CURRENT_YEAR.Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Basic Ordering Agreement</td>
<td>Federal</td>
<td>642,072.00</td>
<td>445,753.00</td>
</tr>
<tr>
<td>A</td>
<td>Basic Ordering Agreement</td>
<td>State of Colorado</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>A</td>
<td>Contract</td>
<td>Federal</td>
<td>1,448,115.41</td>
<td>939,706.41</td>
</tr>
<tr>
<td>A</td>
<td>Contract</td>
<td>Foreign/International</td>
<td>32,901.00</td>
<td>32,901.00</td>
</tr>
<tr>
<td>A</td>
<td>Contract</td>
<td>Local government/districts</td>
<td>507,000.74</td>
<td>455,881.07</td>
</tr>
<tr>
<td>A</td>
<td>Contract</td>
<td>Non-profit organizations/foundations</td>
<td>1,367,828.00</td>
<td>478,090.00</td>
</tr>
<tr>
<td>A</td>
<td>Contract</td>
<td>Other state government</td>
<td>2,075,175.00</td>
<td>1,030,175.00</td>
</tr>
<tr>
<td>A</td>
<td>Contract</td>
<td>Private industry</td>
<td>1,914,704.00</td>
<td>800,607.00</td>
</tr>
<tr>
<td>A</td>
<td>Contract</td>
<td>State of Colorado</td>
<td>599,527.00</td>
<td>599,527.00</td>
</tr>
<tr>
<td>A</td>
<td>Cooperative Agreement</td>
<td>Federal</td>
<td>26,271,467.22</td>
<td>6,053,009.00</td>
</tr>
<tr>
<td>A</td>
<td>Cost Reimbursement Contract</td>
<td>Federal</td>
<td>175,025.00</td>
<td>577,542.00</td>
</tr>
<tr>
<td>A</td>
<td>Cost Reimbursement under Federal Pr</td>
<td>Federal</td>
<td>251,534.00</td>
<td>204,191.00</td>
</tr>
<tr>
<td>A</td>
<td>Grant under Federal Prime</td>
<td>Federal</td>
<td>6,000.00</td>
<td>5,000.00</td>
</tr>
<tr>
<td>A</td>
<td>Non-financial agreements</td>
<td>Federal</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>A</td>
<td>Non-financial agreements</td>
<td>Private industry</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>A</td>
<td>Subcontract</td>
<td>Federal</td>
<td>3,241,906.43</td>
<td>2,700,956.43</td>
</tr>
<tr>
<td>A</td>
<td>Subcontract</td>
<td>Other state government</td>
<td>20,051.80</td>
<td>20,051.80</td>
</tr>
<tr>
<td>A</td>
<td>Subcontract</td>
<td>Private industry</td>
<td>64,676.00</td>
<td>7,200.00</td>
</tr>
<tr>
<td>A</td>
<td>Subgrant</td>
<td>Federal</td>
<td>9,554,765.61</td>
<td>5,827,321.85</td>
</tr>
<tr>
<td>A</td>
<td>Subgrant</td>
<td>Non-profit organizations/foundations</td>
<td>66,565.00</td>
<td>50,979.00</td>
</tr>
</tbody>
</table>

6. To create a calculated field:

a. Press and hold [CTRL] to select the fields that you want to calculate, and click on the Calculate button in the toolbar. Let’s calculate the balance from Cumulative Amount and Current Year Amount:
b. Select Arithmetic as the Operation type, Difference as the Operation, CUMULATIVE_AMOUNT - CURRENT_YEAR_AMT as the Order, name the new calculation BALANCE, and click Insert.

7. Query Studio inserts the new column into your report.

7. Query Studio inserts the new column into your report.

![Image of Query Studio interface showing calculation setup]

8. Save your report as Ch7-Calculation.

---

When adding calculations, always verify that the calculation is logical and would make sense if performed manually. For most simple calculations, the Cognos default properties for summarization produce the expected result. However, it is possible to create scenarios where your report may not reflect the information that you intended, as we will demonstrate in the next exercise.
9. Continuing with this same report, group the report on GRANT_TYPE_DESC to display summary footers for this column.

<table>
<thead>
<tr>
<th>GRANT_TYPE_DESC</th>
<th>STATUS</th>
<th>CATEGORY_DESC</th>
<th>CUMULATIVE_AMOUNT</th>
<th>CURRENT_YEAR_AMOUNT</th>
<th>BALANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Ordering Agreement</td>
<td>A</td>
<td>Federal</td>
<td>642,072.00</td>
<td>445,753.00</td>
<td>196,319.00</td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>State of Colorado</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Contract</td>
<td>A</td>
<td>Federal</td>
<td>1,448,115.41</td>
<td>989,705.41</td>
<td>458,409.00</td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>Foreign/International entity</td>
<td>32,901.00</td>
<td>32,901.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>Local government/districts</td>
<td>502,000.74</td>
<td>455,975.87</td>
<td>46,118.87</td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>Non-profit organizations/foundations</td>
<td>1,267,025.00</td>
<td>476,090.00</td>
<td>811,935.00</td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>Other state government</td>
<td>2,075,175.00</td>
<td>1,830,175.00</td>
<td>245,000.00</td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>Private industry</td>
<td>1,514,704.00</td>
<td>800,607.00</td>
<td>1,114,097.00</td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>State of Colorado</td>
<td>598,257.00</td>
<td>598,257.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

10. Note that the footer reflects the correct total when calculated either across or down. Now we will add a 2nd calculation.

11. Control-click CUMULATIVE_AMT and CURRENT_YEAR_AMT.

12. Click on the Calculate button, select the division operation, and change the order of the two amounts to indicate that we will be dividing CURRENT_YEAR_AMOUNT by CUMULATIVE_YEAR_AMOUNT.

13. Use the New item name option to change the column title to PERCENT CURRENT.
14. Query Studio adds the column, and the detail lines reflect the correct calculation. Note, however, that the footer has added the detail values together to produce an answer that does not make sense.

```
<table>
<thead>
<tr>
<th>Basic Ordering Agreement</th>
<th>Status</th>
<th>Cumulative_Amount</th>
<th>Current_Year_Amount</th>
<th>Percent_Current</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Federal</td>
<td>742,036.00</td>
<td>592,983.00</td>
<td>0.799</td>
<td>149,053.00</td>
<td></td>
</tr>
<tr>
<td>A State of Colorado</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>Contract</td>
<td>742,036.00</td>
<td>592,983.00</td>
<td>0.799</td>
<td>149,053.00</td>
<td></td>
</tr>
<tr>
<td>Federal</td>
<td>5,737,078.41</td>
<td>2,421,205.41</td>
<td>0.422</td>
<td>3,315,873.00</td>
<td></td>
</tr>
<tr>
<td>Foreign/international entity</td>
<td>299,947.00</td>
<td>140,807.00</td>
<td>0.469</td>
<td>159,138.00</td>
<td></td>
</tr>
<tr>
<td>Local government/districts</td>
<td>364,521.27</td>
<td>264,918.40</td>
<td>0.727</td>
<td>99,591.87</td>
<td></td>
</tr>
<tr>
<td>Non-profit organizations/foundation</td>
<td>2,996,116.49</td>
<td>1,525,736.49</td>
<td>0.626</td>
<td>972,380.00</td>
<td></td>
</tr>
<tr>
<td>Other state government</td>
<td>1,281,151.00</td>
<td>447,161.60</td>
<td>0.324</td>
<td>833,040.00</td>
<td></td>
</tr>
<tr>
<td>Private industry</td>
<td>1,014,641.00</td>
<td>706,961.00</td>
<td>0.350</td>
<td>1,107,680.00</td>
<td></td>
</tr>
<tr>
<td>State of Colorado</td>
<td>993,259.00</td>
<td>946,853.00</td>
<td>0.952</td>
<td>47,406.00</td>
<td></td>
</tr>
</tbody>
</table>

**Contract:**

| 13,188,724.17 | 6,552,665.30 | 0.497 | 6,636,058.87 |
```

15. Click in the new field, open the Edit Data menu, and select Summarize (from the menu, not the toolbar).

16. Choose the Advanced option.

17. In the Footers section, select the option to Summarize first, and then apply the calculation.

```
<table>
<thead>
<tr>
<th>Basic Ordering Agreement</th>
<th>Status</th>
<th>Cumulative_Amount</th>
<th>Current_Year_Amount</th>
<th>Percent_Current</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Federal</td>
<td>742,036.00</td>
<td>592,983.00</td>
<td>0.799</td>
<td>149,053.00</td>
<td></td>
</tr>
<tr>
<td>A State of Colorado</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>Contract</td>
<td>742,036.00</td>
<td>592,983.00</td>
<td>0.799</td>
<td>149,053.00</td>
<td></td>
</tr>
<tr>
<td>Federal</td>
<td>5,737,078.41</td>
<td>2,421,205.41</td>
<td>0.422</td>
<td>3,315,873.00</td>
<td></td>
</tr>
<tr>
<td>Foreign/international entity</td>
<td>299,947.00</td>
<td>140,807.00</td>
<td>0.469</td>
<td>159,138.00</td>
<td></td>
</tr>
<tr>
<td>Local government/districts</td>
<td>364,521.27</td>
<td>264,918.40</td>
<td>0.727</td>
<td>99,591.87</td>
<td></td>
</tr>
<tr>
<td>Non-profit organizations/foundation</td>
<td>2,996,116.49</td>
<td>1,525,736.49</td>
<td>0.626</td>
<td>972,380.00</td>
<td></td>
</tr>
<tr>
<td>Other state government</td>
<td>1,281,151.00</td>
<td>447,161.60</td>
<td>0.324</td>
<td>833,040.00</td>
<td></td>
</tr>
<tr>
<td>Private industry</td>
<td>1,014,641.00</td>
<td>706,961.00</td>
<td>0.350</td>
<td>1,107,680.00</td>
<td></td>
</tr>
<tr>
<td>State of Colorado</td>
<td>993,259.00</td>
<td>946,853.00</td>
<td>0.952</td>
<td>47,406.00</td>
<td></td>
</tr>
</tbody>
</table>

**Contract:**

| 13,188,724.17 | 6,552,665.30 | 0.497 | 6,636,058.87 |
```

18. The footer now reflects the logical calculation for CURRENT_YEAR_AMOUNT/CUMULATIVE_YEAR_AMOUNT.

19. Save the report as Ch7-Calculation-Advanced.
20. **NOTE:** in the example above, you could have more easily produced the desired results by selecting Percentage as the Operation type as shown.

21. Cognos automatically uses the proper aggregation, and formats the data as “percent”.

Crosstab Report

22. Continuing with the same report, save it as Ch7-Crosstab.

23. Ctrl-click the STATUS, CURRENT_YEAR_AMOUNT, CURRENT_PERCENT, and BALANCE columns, and click the Delete button in the toolbar. (Do not click the Cut button).

24. Uncheck the option to delete the filter for STATUS.
25. Click in the GRANT_TYPE_DESC column, then click on the Pivot button in the toolbar.

26. Query Studio creates a crosstab report as shown.

27. Modify the report again by clicking on the Swap rows and columns button in the toolbar.

28. The row headings and column headings have “swapped” positions.

29. Save your report.
30. Continuing with the Crosstab report, save it as Ch6-Conditional Formatting.

31. Position your cursor in any one of the data fields to select all of the data fields in the report. Then, in the Change Layout menu, select Define Conditional Styles.

32. Type 10,000,000 into the New value box, click on Insert, then the Up arrow to move it into the Highest value threshold.
33. Select Excellent from the drop-down box.

34. Insert another new value, use the arrow to move it up, and select Average from the drop-down box.
35. Insert 1,000,000 as a new value, move it up with the arrow, and select Below Average in the drop-down box.

36. For anything below 1,000,000, select Poor from the drop-down box.

37. Apply the formatting (or click OK).

38. Save your report, and return to the Cognos Connection page.
Open a Query Studio Report in Report Studio

If you have the access and require additional functionality, or prefer to work in Report Studio, Launch the Report Studio link at the top of the page.

Cognos opens the query in Report Studio, maintaining all of the existing filters, formatting, and other specifications. You may then use Report Studio to revise and refine the query as you choose.

NOTE

You must have the access to Report Studio in order for you to use it. Once a report has been edited with Report Studio, it is no longer possible to open that report with Query Studio.
Chapter 8 – Charts

Charts are a graphical way of presenting data. They can be helpful in visualizing how actual numbers compare to projected numbers, or to analyze trends.

Axes are lines that provide a frame of reference for measurement or comparison:
- The y-axis refers to measures of quantitative data – charts may have more than one y-axis
- The x-axis or ordinal axis plots qualitative data. It runs horizontally, except in bar charts
- The z-axis is the vertical axis in a 3-D chart

When selecting a chart type, you need to think about what you want to illustrate:

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Chart Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parts to a whole</td>
<td>Pie, Stacked configuration</td>
</tr>
<tr>
<td>Trends in time, or contrast values across categories</td>
<td>Line, Area, Bar, Column</td>
</tr>
<tr>
<td>Groups of related information against actual values</td>
<td>Standard configuration, Radar, 3D</td>
</tr>
<tr>
<td>Compare different kinds of quantitative information</td>
<td>Column-line</td>
</tr>
</tbody>
</table>

Create Chart

1. Open with your Ch7-Calculation report with Query Studio.
2. Add a filter to the Balance column to NOT display values < 500000.00

3. To create a chart, click the chart button on the Toolbar:
a. Select a Standard Bar Chart for this data

Note that the chart is displayed in above the list report.

4. Let’s make a new chart which will evaluate how many credits (graduated) students took within the various majors within a particular college:
   a. Create a new report with the Student Detail package
   b. Select the following fields from Academic Outcome:
      - Status
      - College
      - Outcome Graduation Date
      - Major
      - GPA_Credits
   c. Create a Filter on Status, select AW
   d. Remove the Status column but not the filter
   e. Create a Filter for College, Prompt every time report is run, select “IS”
   f. Remove the College column but not the filter
   g. Create a Filter for Graduation date; prompt every time report is run, select year 2007
   h. Remove the column but not the filter
i. You are left with two columns – Major and GPA_Credits
j. Create a pie chart

Title

Create your own new chart report

5. Create a chart report
Chapter 9 – Additional Documentation

There is additional documentation available from the vendor which provides more detail about Cognos Query Studio features.

ODS Metadata

1. Go to the iBanner web page: https://ibanner.du.edu and select the link for the ODS Metadata

2. Select the module you are interested in using

3. There are descriptions of each of the views (Cognos packages contain the views) along with data source information.

4. Make sure that you include the “Recommended Search Columns” in your reports.

5. ODS Business Concept Diagrams may also be helpful as they display how the views are related within the packages.
   a. You will see that key fields are noted in these diagrams – when creating your reports make sure to include key fields for best results.
   b. Note that some of the key fields are repeated in all of the views within the package. You will have better results if you select fields from the same view within the package rather than “joining” fields between packages.
More HELP

6. Click on the Query Studio Help Menu to access the Query Studio User Guide. There is a Query Studio Quick Tour which you may find helpful.

7. Banner 8 Bookshelf – documentation from SunGard
   a. Login to iBanner ➔ My Links ➔ Banner 8 Bookshelf
   b. Banner Operational Data Store ➔ Handbook
   c. Business Concepts and Data Models may be helpful
Chapter 10 – Guidelines

Who Should be Doing What?

You may be wondering why you are learning to use Cognos? What work should I be doing – what work should AIS be doing?

- Our recommendation is that you think about Business Continuity when assessing how best to move forward.
  - Is the report for your own personal use? You are welcome to generate reports from Cognos
  - Is the report going to be used by your entire department? It may be wise to collaborate with AIS to ensure data integrity
  - Will this report be of value across departments? You will want to collaborate with AIS to ensure data integrity
  - Is this a mission critical report? It would be best to have these generated by AIS
  - Do you need a Tab? AIS will need to create Tabs for you

- Whether you or AIS generates the reports, we strongly recommend that you follow the guidelines below

Guidelines for Publishing Cognos Reports
14-Jan-2009 Version 2

There are two types of reports with clear identities: Internal and Distributed.

For Internal reports we recommend you follow most of the same procedures as for Distributed, but we will not enforce the rules and you will not require AIS assistance to put new reports into your internal folders. For Distributed reports, however, we will require all the following tasks to be completed. These procedures may change frequently since this is new to all of us.

In order to comply with the UTS secure computing policy, [http://www.du.edu/uts/policies/securecomputing.html](http://www.du.edu/uts/policies/securecomputing.html), email may not be used as a delivery method for any Cognos report if it contains non-directory information. Please review the Protected Information under the Electronic Data section in the document above to find the definition of directory information. The DU ID is not considered directory information so therefore it cannot be distributed through email.
Distributed Reports:

- Each report must use a standard template available in the DU Report Templates folder. These templates contain the DU Logo, dates and times, and page numbers. Feel free to add more branding to your reports. However, those minimum fields must be on every Distributed report.

- Naming conventions must be enforced. Reports created by departments should begin with the Banner module letter*, followed by a 3 digit number between 100 and 499. Reports created by AIS will again use the module letter but will use numbers between 500 and 999. You may add more descriptive text to the title after these required fields.

- We will require an end-user request and contact information. This is to ensure the solution (report) meets their requirements.

- All Distributed reports must be tested in a test environment (GREEN or GOLD). The developer can create the report in MDB if they prefer, but they must export it to a test environment for user acceptance testing.

- If a summary report is requested we will require a drill-through report to display the details corresponding to the summary report when appropriate.

- Once the end-user has accepted the report, AIS will need the following information in order to put the new Distributed report into production:
  - End-user request
  - Proof of end-user acceptance
  - Report usage - many options are available. Indicate which of the following options are desired:
    - Schedule report and place output in folder
    - Burst report to email or folder or both
    - End user runs the report
    - Place on executive dashboard
  - If individuals will need access to run the report, please have them complete a Banner Access Request Form requesting access to the report.

- The AIS Functional teams will do a final test and approve the project for availability in the appropriate folder.

- The AIS Technical team will complete the process in MDB.

*Banner module letter
A University Advancement
B Budget
F Finance
H HR / Payroll
R Financial Aid
S Student
T Accounts Receivable
W Admissions